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ΕΡΓΑΣΤΗΡΙΟ 13o 

 

ΕΙΣΑΓΩΓΗ ΣΤΗΝ HTML - FRONT PAGE 

 

 

"... Consider a future device for individual use, which is a sort of 
mechanized private file and library. It needs a name, and to coin one at 
random, ``memex'' will do. A memex is a device in which an 
individual stores all his books, records, and communications, and 
which is mechanized so that it may be consulted with exceeding speed 
and flexibility. It is an enlarged intimate supplement to his memory..." 
  
"... All this is conventional, except for the projection forward of 
present-day mechanisms and gadgetry. It affords an immediate step, 
however, to associative indexing, the basic idea of which is a provision 
whereby any item may be caused at will to select immediately and 
automatically another. This is the essential feature of the memex. The 
process of tying two items together is the important thing..." 

 
Vanevar Bush - As We May Think - The 
Atlantic Monthly, July 1945 

 
 

Το πιο συναρπαστικό κοµµάτι του Internet και αυτό που έχει και τους περισσότερους 

χρήστες είναι, πέρα από την υπηρεσία του ηλεκτρονικού ταχυδροµείου, η υπηρεσία 

του World Wide Web (WWW). Το web, όπως αναφέρεται πολλές φορές για 

συντοµία, περιέχει αρχεία µε δυνατότητες πολυµέσων (multimedia) τα οποία έχουν 

επίσης τη δυνατότητα να είναι υπερκείµενα (hypertext). Η ιδιότητα αυτή δεν είναι 

τίποτα άλλο από την ιδιότητα που έχουν µερικά σηµεία του κειµένου (λέξεις-κλειδιά) 

να αποτελούν συνδέσµους που οδηγούν σε ένα άλλο σηµείο του, σε άλλο αρχείο ή 

ακόµα και σε κάποιον άλλο υπολογιστή στο διαδίκτυο. Τα σηµεία αυτά ονοµάζονται 

υπερσύνδεσµοι (hyperlinks) και εκτός από κείµενο µπορεί να είναι εικόνες ή video. Η 

ιδέα του υπερκειµένου αναφέρθηκε για πρώτη φορά από τον Vanevar Bush, τη 

δεκαετία ’40 στο ένα άρθρο του µε τίτλο  As We May Think. 

Η φυσική θέση των ιστοσελίδων (web pages) όπως ονοµάζονται τα αρχεία µε αυτές 

τις δυνατότητες µπορεί να βρίσκεται σε διάφορους υπολογιστές που µπορεί να είναι 

σε διάφορα σηµεία του πλανήτη. Εξ ου και World Wide Web. Η κατασκευή τους 

είναι πολύ απλή σε σχέση µε το εντυπωσιακό αποτέλεσµα που προσφέρουν. Πολλές 

φορές αρκεί ένας κειµενογράφος κι ένα πρόγραµµα πλοήγησης (όπως το Netscape ή ο 
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Explorer). Απαραίτητη προϋπόθεση ήταν η γνώση της γλώσσας HTML. Με τα 

σηµερινά εργαλεία που έχει κανείς στη διάθεσή του δεν απαιτείται η γνώση της 

γλώσσας. Πάντα όµως αν θέλει κανείς να προχωρήσει σε πιο ουσιαστική γνώση και 

εκµετάλλευση όλων των δυνατοτήτων του web πρέπει να είναι εξοικειωµένος και µε 

την HTML. 

 
Η γλώσσα HTML 

Η γλώσσα HTML (HyperText Markup Language) ξεκίνησε ως υποσύνολο της 

γλώσσας SGML (Standard Generalized Markup Language) που εισήγαγε η εταιρεία 

IBM για να λύσει το πρόβληµα της µη τυποποιηµένης εµφάνισης κειµένων σε 

διάφορα υπολογιστικά συστήµατα. Η γλώσσα αποτελείται από κείµενο και tags 

(ετικέτες) που χρησιµοποιούνται για τη µορφοποίηση του κειµένου. 

Τα tags χωρίζονται σε απλά και διπλά. Ξεχωρίζουν από το υπόλοιπο κείµενο γιατί 

περιέχονται µέσα στα σύµβολα <>. Τα διπλά tag ξεκινάνε µε την εντολή µέσα σε <> 

και κλείνουν µε την ίδια εντολή µέσα σε </ >. Συνήθως και για λόγους καλύτερης 

εποπτείας το περιεχόµενο των tags αναγράφεται µε κεφαλαία.  Έτσι αν, για 

παράδειγµα, θέλω να κάνω µια λέξη να φαίνεται µε έντονα γράµµατα (bold) την 

περικλείω µέσα στο διπλό tag <Β> …… </Β>, π.χ. <Β> Καληµέρα!</Β>. Ειδική 

περίπτωση απλού tag  είναι το σχόλιο που περιέχεται στα σύµβολα <!-- ………. -->. 

Αν θέλουµε να παρουσιάσουµε τα ίδια τα σύµβολα < ή > τότε χρησιµοποιούµε την 

ακολουθία χαρακτήρων &lt (Less than) και &gt (Greater than) αντίστοιχα. 

  

<HTML> 

<HEAD> 

<TITLE> Αυτή είναι η πρώτη µου σελίδα! </TITLE> 

</HEAD> 

<BODY> 

<H1> Γεια σου κόσµε!! </Η1> 

</BODY> 

</HTML> 

 

Μπορείτε να γράψετε το παραπάνω κείµενο σε έναν οποιονδήποτε κειµενογράφο 

θέλετε. Μπορείτε να χρησιµοποιήσετε το Notepad των Windows που είναι ο πιο 

απλός. Σώστε το αρχείο µε το όνοµα first.htm και µετά ανοίξτε το από κάποιο 
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πρόγραµµα πλοήγησης (Netscape ή Explorer). Καλώς ήρθατε στην πρώτη σας 

ιστοσελίδα! 

Αν προσέξετε το κείµενο που γράψατε θα παρατηρήσετε ότι γράψατε 19 λέξεις για να 

αναπαραστήσετε 9. Προφανώς σε µια πραγµατική ιστοσελίδα που περιέχει κείµενο, 

πίνακες, εικόνες και Video µε διάφορες ιδιότητες καθώς και υπερσυνδέσµους θα 

υπάρχει µια αντίστοιχη αναλογία µεταξύ πραγµατικού περιεχοµένου και ετικετών 

ελέγχου. Είναι προφανές ότι η κατασκευή ιστοσελίδων µε αυτό τον τρόπο είναι 

αρκετά χρονοβόρα. Σήµερα βέβαια διατίθενται πολλά προγράµµατα που δίνουν τη 

δυνατότητα ακόµα και σε ένα µικρό παιδί να κατασκευάσει τις ιστοσελίδες του µε 

µεγαλύτερη ευκολία. Ένα από αυτά είναι και FrontPage της εταιρείας Microsoft που 

θα δούµε παρακάτω. 

Πριν από αυτό ας πούµε µερικά ακόµα πράγµατα για την HTML. Και συγκεκριµένα 

ας δούµε µε ποια διαδικασία κατασκευάζονται οι περίφηµοι υπερσύνδεσµοι. Στο 

αρχείο που γράψατε παραπάνω προσθέστε αµέσως µετά το <H1> Γεια σου κόσµε!! 

</Η1> τα εξής:  

<P> <P> <A HREF=mailto:sysadmin@teiser.gr> System Administrator</A> <P> 

Το tag <Ρ> είναι ένα µονό tag που δηλώνει αλλαγή γραµµής και εισαγωγή µιας κενής 

γραµµής. Το διπλό tag <Α> ορίζει έναν υπερσύνεσµο. Η παραπάνω πρόταση 

εµφανίζει στην οθόνη του προγράµµατος πλοήγησης τις λέξεις System Administrator 

και δίνει σε αυτές την ιδιότητα να αποτελούν υπερσύνδεσµο προς µια ηλεκτρονική 

διεύθυνση που είναι η sysadmin@teiser.gr.  

Αν σώσετε πάλι το αρχείο µε το ίδιο όνοµα και το ξανανοίξετε από κάποιο 

πρόγραµµα πλοήγησης θα το δείτε να παρουσιάζεται µε τη γνωστή µορφή των 

υπερσυνδέσµων, δηλαδή µπλε και υπογραµµισµένο. Αν πατήσετε µε το ποντίκι πάνω 

του, το πρόγραµµα πλοήγησης θα καλέσει το πρόγραµµα που είναι ορισµένο να 

εξυπηρετεί το ηλεκτρονικό ταχυδροµείο στον συγκεκριµένο υπολογιστή και θα 

προετοιµαστεί να αποστείλει e-mail στην διεύθυνση του υπερσυνδέσµου. 

 

Το πρόγραµµα FrontPage 

Παρακάτω θα δούµε τον τρόπο µε τον οποίο µπορούµε να φτιάξουµε µια ιστοσελίδα 

µε τη χρήση του προγράµµατος Microsoft Front Page. Υπάρχουν πολλά προγράµµατα 

µε τα οποία µπορούµε να κάνουµε τις ίδιες εργασίες. Θα χρησιµοποιήσουµε το 

συγκεκριµένο γιατί είναι από τα πιθανότερα να βρείτε εγκατεστηµένο σε κάποιον 

υπολογιστή όπου θα κληθείτε να δουλέψετε.  
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Μη ξεχνάτε ότι όπως µε τη συγγραφή ενός οποιοδήποτε κειµένου ή την ζωγραφική 

ενός πίνακα, δεν αρκεί να γνωρίζουµε τα εργαλεία που υπάρχουν ή ακόµη και τη 

χρήση τους.  Το ότι ο υπολογιστής σας διαθέτει έναν κειµενογράφο, του οποίου 

γνωρίζετε όλες τις δυνατότητες (έτσι τουλάχιστον ελπίζω), δεν σας µετατρέπει σε 

ποιητή αντάξιο του Καβάφη ή συγγραφέα αντάξιο του Καζαντζάκη. Το ίδιο ακριβώς 

συµβαίνει µε τις ιστοσελίδες. Μπορείτε να µάθετε τα εργαλεία που υπάρχουν για να 

σας βοηθήσουν να δώσετε µορφή στις ιδέες σας αλλά, δυστυχώς ή ευτυχώς, η 

φιλοτέχνηση των ιστοσελίδων σας είναι θέµα προσωπικού ταλέντου και έµπνευσης. 

 

Σώστε τη δουλειά σας για να σώσετε το χρόνο σας. 

Ξεκινήστε µια καινούργια σελίδα και σώστε την σύµφωνα µε την παρακάτω 

διαδικασία.  

 
 

Όπως κάθε αρχείο έτσι και µια ιστοσελίδα έχει ένα όνοµα. Οι ιστοσελίδες διαθέτουν 

επίσης ένα ακόµα χαρακτηριστικό όνοµα. Αυτό είναι ο τίτλος που θα φαίνεται από το 

πρόγραµµα πλοήγησης όταν κάποιος επισκέπτης θα βλέπει τη σελίδα σας. Το όνοµα 

αυτό ορίζεται στην παρακάτω µάσκα. 
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Καλό είναι για κάθε αρχείο να επιλέγετε ένα χαρακτηριστικό όνοµα για να το 

θυµάστε.  

 

 
 

 

 

∆ώστε χρώµα στις σελίδες σας (και στη ζωή σας) 

 

Χρώµα φόντου. 

Format -> Background … ->  

 

 
 

Βάλτε κείµενο 

Αφού αποφασίσατε να δηµιουργήσετε µια ιστοσελίδα σηµαίνει ότι αποφασίσατε να 

επικοινωνήσετε µε κάποιους ανθρώπους. Πρέπει λοιπόν να προσθέσετε κείµενο στις 

σελίδες, εφόσον έχετε κάτι να πείτε. 

Αν δεν είστε σε κατάσταση Page View πατήστε το κατάλληλο κουµπί. 
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Επίσης σιγουρευτείτε ότι βλέπετε τη σελίδα σας σε Normal κατάσταση. 

 

\ 

 

Τοποθετήστε τον κέρσορα στη θέση της σελίδας που θέλετε και γράψτε το κείµενό 

σας. Μπορείτε να µορφοποιήσετε το κείµενο, µε τον ίδιο τρόπο που θα 

µορφοποιούσατε ένα κείµενο στο Word. Μπορείτε να ελέγξετε το µέγεθος και τη 

γραµµατοσειρά των γραµµάτων, το χρώµα τους ή ακόµα και ειδικά εφέ. 

Αφού γράψετε το κείµενό σας µην ξεχάσετε να σώσετε τη σελίδα. 

 

Βάλτε εικόνες στις σελίδες σας. 

 

Επιλέξτε µια εικόνα σχετική µε το θέµα σας. Μια εικόνα αξίζει όσο χίλιες λέξεις, για 

αυτό επιλέξτε την προσεκτικά. 

 
Σηµείωση: Πολλοί χρήστες του παγκόσµιου ιστού προτιµούν να περιηγούνται στο 

διαδίκτυο έχοντας απενεργοποιήσει την εµφάνιση εικόνων από το πρόγραµµα 

πλοήγησης. Αυτό γίνεται για λόγους οικονοµίας στο εύρος ζώνης που διαθέτουν. Για 

το λόγο αυτό είναι καλό να προγραµµατίσετε έτσι τη σελίδα σας ώστε στην 

περίπτωση αυτή να εµφανίζεται στη θέση της εικόνας κάποιο κείµενο που να την 

περιγράφει.  
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Είναι επίσης σηµαντικό να γνωρίζετε ότι µε αυτό τον τρόπο κάνετε τις σελίδες σας 

προσβάσιµες και από ανθρώπους που έχουν προβλήµατα όρασης. Οι άνθρωποι αυτοί 

χρησιµοποιούν προγράµµατα ανάγνωσης σελίδων που ψάχνουν το εναλλακτικό 

κείµενο και περιγράφουν την εικόνα µέσω αυτού. 

Για να ορίσετε εναλλακτικό κείµενο επιλέξτε την εικόνα, κάντε αριστερό κλικ πάνω 

της και πηγαίνετε στο µενού Picture Properties … 

Στο κουτί Alternative Representations γράψτε το κείµενο που χαρακτηρίζει την 

εικόνα σας. 

 
 

 
Όταν µετά πάτε µε το ποντίκι πάνω στην εικόνα θα δείτε το εναλλακτικό αυτό 

κείµενο. 

 

Ρύθµιση της σχετικής θέσης των εικόνων µε το κείµενο 

Μπορείτε να τοποθετήσετε τις εικόνες είτε σε σχετική θέση µε το κείµενο, είτε στην 

απόλυτη θέση όπου θα εµφανίζεται κάθε φορά, είτε χωρίς καµία σχετική ρύθµιση. 
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Όλες αυτές οι ρυθµίσεις µπορούν επιλέγοντας την εικόνα και µετά Format -> 

Position… 

 
 

∆ιαχείριση εικόνων 

Υπάρχουν πολλά εφέ που µπορείτε να κάνετε µε τις εικόνες των ιστοσελίδων σας. 

Μερικά από αυτά είναι να τις τοποθετήσετε ως φόντο στο κείµενο ή µα κάνετε 

κάποια σηµεία τους διάφανα και κάποια όχι. Πολλά από τα εφέ αυτά είναι δυνατό να 

υλοποιηθούν µόνο οι εικόνες είναι σωσµένες σε µορφή .gif. 

 

∆ιάφανες εικόνες 

Στην παρακάτω εικόνα µπορείτε να κάνετε το µπλε χρώµα της πρώτης διάφανο, 

επιλέγοντάς το µε το κατάλληλο εργαλείο  από τη µορφοποίηση εικόνας. 

 

 

 
 

Πριν Μετά
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Interlaced 

Μια άλλη τεχνική που µπορείτε να χρησιµοποιήσετε είναι αυτή που επιτρέπει το 

σταδιακό «φόρτωµα» µιας εικόνας. Με την επιλογή Interlaced µπορείτε να κάνετε 

µια εικόνα να εµφανίζεται από την αρχή ολόκληρη αλλά µε µειωµένη ανάλυση. Η 

εικόνα θα βελτιώνεται σταδιακά καθώς θα φορτώνεται η σελίδα σας. Αν δεν 

χρησιµοποιήσετε αυτή την τεχνική, τότε η εικόνα θα εµφανίζεται σιγά-σιγά, σαν να 

γεµίζει, από πάνω προς τα κάτω. Για να το κάνετε αυτό επιλέγετε µετά από δεξί κλικ 

επί της εικόνας, το picture properties… -> General Tab και µετά την επιλογή 

interlaced. 

 

 
 

Κίνηση µε DHTML. 

Μπορείτε να χρησιµοποιήσετε ειδικά εφέ στο κείµενο και στις εικόνες σας µε τη 

χρήση της Dynamic HTML. Με τον τρόπο αυτό µπορείτε να κάνετε κάποιο µέρος 

του κειµένου να κινείται ή να αλλάζει µέγεθος υπό κάποιες συνθήκες (π.χ. αν 

τοποθετήσετε τον δείκτη του ποντικιού επάνω του). Για να ενεργοποιήσετε αυτά τα 

εφέ επιλέξτε την εικόνα ή το κείµενο και πηγαίνετε στο Format…->Dynamic HTML 

Effects κι εκεί επιλέξτε τις συνθήκες υπό τις οποίες θα συµβαίνει το εφέ και το είδος 

του εφέ. 

 
Προσοχή: Μην «βαραίνετε» τις σελίδες σας µε πολλά εφέ και κίνηση. 

Χρησιµοποιήστε τα κυρίως για να τονίσετε κάτι ιδιαίτερο. Τα πολλά εφέ µπορεί να 

κουράσουν τον επισκέπτη του δικτυακού σας τόπου. 

Περιστροφή, αλλαγή µεγέθους και επιλογή περιοχής από εικόνα 

Τα εργαλεία επεξεργασίας εικόνων µας δίνουν τη δυνατότητα να περιστρέψουµε 

εικόνες ως προς οποιονδήποτε άξονα περιστροφής. Μπορούµε για παράδειγµα να 

γυρίσουµε µια εικόνα πάνω-κάτω, να δηµιουργήσουµε το είδωλό της σαν σε 

καθρέπτη ή να την περιστρέψουµε µε συγκεκριµένη φορά και γωνία στροφής. 
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Αυτά γίνονται από τα εργαλεία διαχείρισης εικόνων   

Μπορούµε επίσης να κόψουµε ένα κοµµάτι µιας εικόνας για να χρησιµοποιήσουµε 

µόνο αυτό στη σελίδα µας. Αυτό γίνεται µε χρήση του εργαλείου crop . 

Τέλος µπορούµε να αλλάξουµε το µέγεθος µιας εικόνας µε την εξής διαδικασία. 

Επιλέγουµε την εικόνα. Στα όριά της εµφανίζονται τετραγωνάκια. Αν τοποθετήσετε 

το δείκτη του ποντικιού πάνω στα τετραγωνάκια αυτός γίνεται αµφίδροµο βέλος. Με 

πατηµένο το αριστερό πλήκτρο του ποντικιού σέρνετε το άκρο της εικόνας που 

«πιάσατε» και την αφήνετε στο νέο επιθυµητό µέγεθος. Προσέξτε ότι η αλλαγή 

µεγέθους είναι διαφορετική από την αποκοπή µέρους της εικόνας. 

 

Thumbnails 

Πολύ συχνά και για να µπορέσουµε να παρουσιάσουµε περισσότερες φωτογραφίες σε 

µια σελίδα, τις µετατρέπουµε σε thumbnails. Αυτό σηµαίνει ότι στη θέση της 

φωτογραφίας εµφανίζεται µια σµίκρυνση της η οποία συσχετίζεται µέσω ενός 

υπερσυνδέσµου µε το σηµείο στο οποίο είναι αποθηκευµένη η φωτογραφία. Αν ο 

χρήστης επιθυµεί να δει τη φωτογραφία σε φυσικό µέγεθος ή ακόµα και να την 

κατεβάσει στον υπολογιστή του, αρκεί να πατήσει πάνω της µε τον δείκτη του 

ποντικιού. 

Για να µετατρέψουµε µια εικόνα σε thumbnail πρέπει αρχικά να είµαστε σε 

κατάσταση Page View. Μετά να εισάγουµε την εικόνα που θέλουµε στο επιθυµητό 

σηµείο και να την επιλέξουµε. Από το µενού διαχείρισης εικόνων που εµφανίζεται 

πατάµε το κουµπί . Η εικόνα δεν θα µετατραπεί σε thumbnail αν είναι ήδη 

µικρότερη από αυτό ή αν έχει κάποιον υπερσύνδεσµο ή αν είναι κάποιου είδους 

κινούµενη εικόνα. 

Αν θέλετε να αλλάξετε τις ρυθµίσεις που ισχύουν για τη δηµιουργία thumbnails 

πηγαίνετε στο Tools -> Options -> AutoThumbnail. Εκεί µεταξύ άλλων µπορείτε να 

ρυθµίσετε το µέγεθος των thumbnails σε Pixels. Αν για παράδειγµα επιλέξετε πλάτος 

(Width) ίσο µε 100 pixel τότε η άλλη διάσταση θα ρυθµιστεί αυτόµατα ώστε να 

διατηρηθούν οι αναλογίες στη φωτογραφία σας. 
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ΥΠΕΡΣΥΝ∆ΕΣΜΟΙ 

Αυτό που κάνει τις ιστοσελίδες να ξεχωρίζουν από ένα οποιοδήποτε άλλο κείµενο 

είναι η ύπαρξη υπερσυνδέσµων. Μπορείτε να φανταστείτε τους υπερσυνδέσµους σαν 

µαγικά τούνελ που σε ταξιδεύουν αυτόµατα από ένα σηµείο σε κάποιο άλλο. Έτσι 

ένας υπερσύνδεσµος µπορεί να σε στείλει: 

 Σε κάποιο άλλο σηµείο στην ίδια ιστοσελίδα 

 Σε κάποια άλλη σελίδα του δικού σου δικτυακού τόπου 

 Σε έναν άλλο δικτυακό τόπο. 

  

Για να µετατρέψετε κάποιο κείµενο σε υπερσύνδεσµο: επιλέξτε το κείµενο και 

πατήστε το κουµπί   που βρίσκεται στη βασική γραµµή εργαλείων. Στο µενού 

που εµφανίζεται γράψτε το όνοµα της σελίδας στην οποία θέλετε να πάτε. Αν θέλετε 

ο υπερσύνδεσµος να σας µεταφέρει σε άλλο δικτυακό τόπο γράψτε τη διεύθυνση 

(URL) µέσα στο κουτί µε το όνοµα URL. Μπορείτε επίσης να µετατρέψετε µια 

εικόνα σε υπερσύνδεσµο µε την ίδια ακριβώς διαδικασία. 

Μπορείτε να ορίσετε ως προορισµό του υπερσυνδέσµου σας την ηλεκτρονική 

ταχυδροµική διεύθυνση κάποιου. Για παράδειγµα οι κατασκευαστές ή οι συντηρητές 

δικτυακών τόπων όταν υπογράφουν τη σελίδα τους, ορίζουν το όνοµά τους ως 

υπερσύνδεσµο προς το e-mail τους. Με τον τρόπο αυτό κάποιος επισκέπτης της 

σελίδας µπορεί να επικοινωνήσει µαζί τους για να τους αναφέρει κάποιο πρόβληµα 

µε τη σελίδα ή για να κάνει µια πρόταση για τη βελτίωσή της. Για να ορίσετε ένα 

κοµµάτι κειµένου ως υπερσύνδεσµο σε e-mail ακολουθείτε τη ίδια διαδικασία µε την 

παραπάνω. ∆ίπλα στο κουτί URL υπάρχουν κάποια κουµπιά. Πατάτε το  και 

εµφανίζεται ένα µενού όπου µπορείτε να γράψετε την ηλεκτρονική διεύθυνση που 

θέλετε να συσχετίσετε µε το κείµενο. Μετά φυσικά πατάτε ΟΚ.  

 

∆ύο από τα πιο ενδιαφέροντα πράγµατα που µπορείτε να κάνετε µε τους 

υπερσυνδέσµους είναι να κατασκευάζετε links για σηµεία της ίδιας σελίδας (π.χ. από 

τα περιεχόµενα ενός κειµένου να µπορεί ο αναγνώστης να πάει στις αντίστοιχες 

παραγράφους), και να κατασκευάζετε διαφορετικούς συνδέσµους χρησιµοποιώντας 

διαφορετικά σηµεία της ίδιας φωτογραφίας. 



Κ. Σ. Χειλάς                          Τ.Ε.Ι. Σερρών - Τµήµα Πληροφορικής και Επικοινωνιών 
 

Εργαστήριο ∆ίκτυα Η/Υ Ι. 12

Για να δηµιουργήσετε σύνδεσµο σε ένα σηµείο της ίδιας σελίδας πρέπει πρώτα να 

κατασκευάσετε bookmark στο σηµείο προορισµού του συνδέσµου. Αυτό γίνεται 

αφού επιλέξετε το κείµενο προορισµό και µετά από το µενού Insert -> Bookmark… 

Έπειτα επιλέγετε το κείµενο που θα γίνει υπερσύνδεσµος και ακολουθείτε τη γνωστή 

διαδικασία. Ως URL επιλέγετε τη σελίδα στην οποία βρίσκεστε και µετά από την 

επιλογή Bookmark το όνοµα του σηµείου στο οποίο θέλετε να καταλήγει ο 

σύνδεσµος. 

 

 
Ας δούµε τώρα µε ποιόν τρόπο µπορείτε να κατασκευάσετε υπερσυνδέσµους 

χρησιµοποιώντας διαφορετικά σηµεία της ίδιας φωτογραφίας. Κάθε διαφορετικός 

σύνδεσµος εντός της εικόνας λέγεται hot-spot. Αν, για παράδειγµα, θέλετε να 

κατασκευάσετε έναν δικτυακό τόπο για µια πόλη και θέλετε να αφιερώσετε µια 

σελίδα σε κάθε γειτονιά ή περιοχή της πόλης. Μπορείτε να χρησιµοποιήσετε την 

εικόνα ενός χάρτη της πόλης και να ορίσετε έτσι την εικόνα ώστε κάθε γειτονιά στον 

χάρτη να είναι ένα hot-spot και να σε συνδέει µε τη σελίδα της γειτονιάς αυτής. 

Για να ορίσετε σε µια εικόνα µερικά hot-spots επιλέξτε αρχικά την εικόνα. Στη 

γραµµή εργαλείων εικόνας (Image toolbar) πατήστε το κουµπί Polygon . 

Πηγαίνετε τον δείκτη του ποντικιού πάνω από την εικόνα. Παρατηρείστε ότι ο 

δείκτης γίνεται σαν µολύβι ή καλύτερα σαν κοπίδι. Σχηµατίστε µε τον δείκτη, 
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πατώντας και σέρνοντας το ποντίκι, την περιοχή της εικόνας που θέλετε να ορίσετε 

σαν hot-spot. Με το που σχηµατίζετε µια κλειστή περιοχή θα εµφανιστεί ένα κουτί 

διαλόγου που είναι το γνωστό σας από πριν Create Hyperlink. Ορίστε µε τη γνωστή 

διαδικασία τον υπερσύνδεσµο που θέλετε να πηγαίνει ο αναγνώστης της σελίδας σας 

όταν πατάει πάνω σε εκείνη την περιοχή. Πατήστε τέλος ΟΚ. 

Μην ξεχνάτε ότι όλα σχεδόν τα προγράµµατα διαθέτουν ένα κουµπί (Undo) που 

ακυρώνει τυχόν εσφαλµένες ενέργειές σας. Έτσι έχετε τη δυνατότητα να ξανακάνετε 

τα hot spots αν δεν τα πετύχατε καλά µε την πρώτη. 

 

Τι επίδραση έχουν τα γραφικά στον δικτυακό σας τόπο – Μερικές συµβουλές. 

Ασχοληθήκαµε παραπάνω κυρίως µε την διαχείριση γραφικών στις ιστοσελίδες. 

Κανείς δεν µπορεί να αρνηθεί ότι τα γραφικά οµορφαίνουν έναν δικτυακό τόπο, τον 

κάνουν πιο ελκυστικό και πολλές φορές µεταφέρουν ευκολότερα τα µηνύµατα του 

συγγραφέα του. Παρόλα αυτά υπάρχουν µερικά θέµατα που πρέπει να γνωρίζετε όταν 

θέλετε να κάνετε την ιστοσελίδα σας πιο ελκυστική. 

 

Αύξηση του µεγέθους του δικτυακού τόπου. 

Όταν προσθέτετε γραφικά, όπως εικόνες, κινούµενες εικόνες ή και βίντεο στην 

ιστοσελίδα σας, το µέγεθός της αυξάνει ταχύτατα. Επειδή η ιστοσελίδα σας συνήθως 

θα φιλοξενείται σε κάποιον εξυπηρετητή (server) ενός παροχέα υπηρεσιών 

διαδικτύου (ISP – Internet Service Provider), θα πρέπει να είστε ιδιαίτερα 

προσεκτικοί µε το µέγεθος. Συνήθως υπάρχει περιορισµός στο µέγεθος του δικτυακού 

σας τόπου που µπορεί να φιλοξενηθεί κάπου. Για το λόγο αυτό σκεφτείτε ιδιαίτερα 

σχετικά µε το µέγεθος, την ποιότητα και τον αριθµό των γραφικών που θα 

χρησιµοποιήσετε.  

Μερικοί τρόποι που µπορείτε να χρησιµοποιήσετε για να κάνετε τα αρχεία εικόνας 

µικρότερα είναι οι εξής: 

Κάντε µια µεγάλη εικόνα µικρότερη µικραίνοντας τις διαστάσεις της (resizing) και 

αλλάζοντας τη δειγµατοληψία της (resampling). Αν απλά µικρύνετε τις διαστάσεις 

µιας φωτογραφίας δεν επηρεάζεται σηµαντικά το µέγεθος του αρχείου. Θα πρέπει να 

αλλάξετε και τη δειγµατοληψία της και ουσιαστικά την ανάλυσή της.  

Μετατρέψτε τις φωτογραφίες σε µορφή .JPEG και µικρύνετε τη ρύθµιση ποιότητας 

(Quality). Όσο ελαττώνετε αυτή τη ρύθµιση αυξάνεται η συµπίεση του αρχείου κι 

εποµένως ελαττώνεται το µέγεθός του. 
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Για εικόνες υψηλής ανάλυσης, αντιγράψτε τις και ελαττώστε την ανάλυσή τους. 

Όλες οι παραπάνω επεµβάσεις σε εικόνες γίνονται µε τα περισσότερα προγράµµατα 

επεξεργασίας εικόνων (π.χ. Adobe Photoshop). 

 

Για σελίδες που «κατεβαίνουν» αργά. 

Τα γραφικά, λόγω του µεγέθους των αρχείων τους, απαιτούν αρκετή ώρα για να 

κατέβουν. Ειδικά αν ο επισκέπτης της σελίδας µας έχει αργή σύνδεση στο διαδίκτυο. 

Παρακάτω αναφέρονται µερικοί τρόποι για να κάνετε τα γραφικά των σελίδων σας 

πιο γρήγορα για τους επισκέπτες σας. 

Αλλάξτε το µέγεθος και την ανάλυση των φωτογραφιών. 

∆ηµιουργήστε Thumbnails. Με τον τρόπο αυτό σελίδα σας περιέχει µια µικρή έκδοση 

της αρχικής εικόνας. Ο επισκέπτης µπορεί να δει τις εικόνες και αν τον ενδιαφέρει 

κάποια ιδιαίτερα, να κατεβάσει την κανονική έκδοση πατώντας πάνω στο thumbnail. 

Παρουσιάστε εναλλακτικό κείµενο (ALT Text). Αυτό είναι κείµενο που εµφανίζεται 

στη θέση µιας εικόνας όση ώρα αυτή φορτώνεται. Με τον τρόπο αυτό δίνεται στον 

επισκέπτη της σελίδας σας, µια ιδέα του τι περιµένει να δει. 

Παρουσιάστε µια έκδοση χαµηλής ανάλυσης της εικόνας. Μπορείτε να 

κατασκευάσετε µια έκδοση της εικόνας µε πολύ χαµηλή ανάλυση και να 

παρουσιάζετε αυτήν όση ώρα φορτώνει η κανονική.  

Αυτός ο τρόπος όπως και ο προηγούµενος δεν γλιτώνει τον χρήστη από το χρόνο που 

χρειάζεται για να φορτώσει η πραγµατική εικόνα. Τον προϊδεάζει όµως για αυτό που 

περιµένει να φορτωθεί και του δίνει τη δυνατότητα να δεν τον ενδιαφέρει να 

προχωρήσει σε κάποιο άλλο σηµείο του δικτυακού µας τόπου.  

Για να δείτε ποιες από τις σελίδες του δικτυακού σας τόπου είναι αργές, πηγαίνετε 

στο µενού View -> Reports -> Slow Pages. 

 

Άσκηση 

Χρησιµοποιήστε όσα µάθατε εδώ για να κατασκευάσετε µια πρώτη µορφή της 

ιστοσελίδας σας. Καλό είναι αυτή να αποτελείται τουλάχιστον από τρεις σελίδες. 

Αυτές θα πρέπει να είναι συνδεδεµένες µεταξύ τους µε υπερσυνδέσµους και να 

περιέχουν γραφικά της αρεσκείας σας στην παρουσίαση των οποίων θα 

χρησιµοποιήσετε όλες τις παραπάνω τεχνικές. 


